LRI <5

LIVESTOCK RFSFARCH

NSTITUTE CGIAR

Vietnamese Pig Sector Model 2014

User Manual

Version 1

Nicholas Minot?, Karl Rich?, Nguyen Ngoc Que? and Nguyen Anh Phong?

1 International Food Policy Research Institute
2 Norwegian Institute of International Affairs

3 Institute of Policy and Strategy for Agriculture and Rural Development, Vietnam.

July 2015



© 2015

This publication is licensed for use under the Creative Commons Attribution-
Noncommercial-Share Alike 3.0 Unported Licence. To view this licence, visit
http://creativecommons.org/licenses/by-nc-sa/3.0/. Unless otherwise noted, you are free to copy,
duplicate, or reproduce and distribute, display, or transmit any part of this publication or portions
thereof without permission, and to make translations, adaptations, or other derivative works under

the following conditions:

® ATTRIBUTION. The work must be attributed, but not in any way that suggests endorsement by
the publisher or the author(s).

@ NON-COMMERCIAL. This work may not be used for commercial purposes.

@ SHARE ALIKE. If this work is altered, transformed, or built upon, the resulting work must be
distributed only under the same or similar license to this one.

firi.org
better lives through fivestock
ILR! is 2 member of the CGIAR Consortium
Bax 30709, Nairobi 00100, Kenya Box 5689, Addis Ababa. Ethiopia
Phone: +254 20 422 3000 Phone: +251 |1 617 2000
Fax; 4254 20 422 3001 Fax; 4251 11 617 2001

Email; ILRI-Kenyai@cgiar.org Email: ILRI-Ethiopia@cgiar.org


http://creativecommons.org/licenses/by-nc-sa/3.0/

Contents

FOP@WOI....ieie ettt ettt b e bt e s bt e s at e et e et e e b e e sh e e s aeesaee st e e bt e b e eabeenmeesmeeeneeennean 4
N ) { oo [¥ Tt d T o PSSO P PRSP PP PROPPRRTN 5
2. How to set up and run the VPM2014 MOEl ......cccuviieeiiiiieeiiie ettt e e 6
GAMS MOAEIING SYSTEIM ..tiiiiiiiiie ettt e e s sttt e s sebte e e e sbeeeessbeeeesssteeessaseeeessnes 6
Creating @ GAIMS PrOJECE. c.i ittt ettt e e e e et e e e e e s s e abb ittt e e e e e s essssbbtaaaeeeesannnneaeaeens 6
Opening the VPM2014 Model files of GAMS iNSTrUCtiONS.....ccvvieiiiciiiieiiiiiee et e e 8
Ensuring the Excel input and output files is available to GAMS .........ccoviiieiiii e, 9
RUNNING the VPIM2014 IMOUEL.......uiiieeeiiee ettt e ettt e et e e e e arae e e e ate e e e enbaeeeenbaeeeenarenas 9
Opening and navigating around the OULPUL ........cccciiiii i 10
3. How to make changes to the VPM2014 Model StrUCTUIe ......ccoevcivriiieeeee et e e 12
Ways to find and/or replace teXt StIINES ......ccvecveeiiiiiiiie ettt re b ereete e te e reesabeeabeearees 12
4. How to make changes to Model INPULS .......coiiiiiiiiiiciiie e e 13
5. How to set up and change VPM2014 output tables.......c.ccooeeiieeicciii e 15
F YT o1<] o Vo [ SR PUPRPOE 17
Appendix 1: Definition of Model SEBt NAMES .......vviiieiieeeece e e e 17
Appendix 2: Definition of model input parameters......ccoceii i 17
Appendix 3: Definition of model variables, equations & other parameters ........ccccoccvvvevvieeeecnnen. 18
Appendix 4: Definition of summary model output parameters ......ccccceeecieeeevciee s, 20
Appendix 5: Definition of Model COre StrUCTUIE .........vviiiiciieec e e 20



Foreword

The Vietnam Pig Sector Model (VPM) was initially developed under a project funded by The
Australian Centre for International Agricultural Research (ACIAR) entitled Improving
Competitiveness of Pig Producers in an Adjusting Vietnam Market. The project was
implemented by the International Livestock Research Institute (ILRI). The modelling
component of this project was carried out by the International Food Policy Research
Institute (IFPRI) under a subcontract to ILRI.

The initial version of the Vietnam Pig Sector Model was constructed in 2010 by Nicholas Minot?,
Karl Rich? and their Vietnamese collaborators — Nguyen Ngoc Que® and Nguyen Anh Phong.
With help from a collaborative research started in late of 2010 between ILRI and Center for
Agricultural Policy (CAP), the model was substantially upgraded.

1 Senior Research Fellow, International Food Policy Research Institute (IFPRI), Washington, DC, USA.

2 Senior Research Fellow, Norwegian Institute of International Affairs (NUPI), Oslo, Norway.

3 Center for Agricultural Policy (CAP), Institute of Policy and Strategy for Agriculture and Rural Development
(IPSARD), Hanoi, Vietnam.



1. Introduction

The Vietnam Pig SecTor Model of the upgraded version in 2014, VPM2014, is a spatial
recursive-dynamic non-linear programming model of Vietnam’s pig sector, developed within
the General Algebraic Modeling System (GAMS) framework. The VPM2014 model solves
simultaneously for the consumer and producer equilibrium prices in related urban and rural
markets of all seven regions in Vietnam by Mixed-Complementary-Problems Solver. Supply
and demand are functions of price, all markets must clear (production plus imports equals
consumption plus exports) and price relationships must hold. Price relationships are held
through the following assumptions:

a) Producer and consumer prices relate through margins;

b) Regional prices are linked through transport and marketing costs so that the relationship
between regional prices is maintained.

c) Domestic prices and world prices relate through import and export margins;

The demand side of the model is represented by a log-log model where price elasticities are
calculated from an underlying regional urban-rural AIDS model for food expenditure
calculated for budget shares in the base year. Over a ten year time horizon urban-rural
income and population growth determine demand for a product.

The model is dynamic in that it projects changes over time in response to demand growth
driven by income and population growth. Productivity growth in terms of crop productivity,
yield per animal and food conversion ratios drive growth in output over time. Aside from
food demand, treatment of the interaction between the Vietnamese pig sector and the rest
of the economy is dealt with by using exogenous parameter assumptions that reflect
economic growth paths, such as changes in urban and rural income, population and world
prices.

The aim of this User Manual is to provide a guide on how to:

v' Set up and run the VPM2014 model;
Make changes to the VPM2014 model structure;
Make changes to model inputs; and

AN

Control model outputs.



2. How to set up and run the VPM2014 model

GAMS modelling system

VPM2014 model uses the General Algebraic Modeling System (GAMS). GAMS software can
be downloaded for free from the supplier, but to run a model of more than a specific
number of variables a GAMS licence for specific solvers needs to be purchased. VPM2014
requires the basic licence which includes the necessary MCP solver?.

GAMS can run from an operating system command line or on Windows machines using the
Integrated Development Environment (IDE). Our user manual is based on use of IDE. IDE is
designed to allow editing, development, debugging and running GAMS works in one
program. Once installed, the IDE interface can be opened through the icon, start menu or
Explorer.

Creating a GAMS project

The first step in running the VPM2014 model is to create a new GAMS project. The IDE
employs a ‘Project’ file for two reasons:

a) The project location determines where files are saved and where GAMS looks for files
when executing; and

b) The project saves file names and program options associated with the effort in a file
called projectname.gpr.

To create a new project, select the ‘File’ menu in the upper left corner of IDE, select ‘Project’
and ‘New Project’ (Figure 1). Define a project name and locate the project in a directory
where you want to use. All files associated with this project will be saved in that directory.

Edit Search Windows Utilities Model Libraries Help

Mew CtrleM (] JJJ |

Open Ctrl+ O

Open in Editor

OQpen in project directony

Recpen Alt+R
Open in Mew Window Shift+ Ctrl+ O

View in Explorer

Model Library 2
Project 2 Open Project
Run g Mew Project

Figure 1: Saving a new project screenshot

In the "File name" area, enter in a name for the project file you wish to use (e.g.
“VPM2014") (see Figure 2). This defines the directory where the files you wish to access are

4 Licence terms and conditions are available from GAMS.



located (those specified without full file path names). The extension ‘gpr’ stands for GAMS
project.

Figure 2: Defining the project file name screenshot



Opening the VPM2014 Model files of GAMS instructions

VPM2014 contains four files of GAMS instructions:

a)
b)
c)
d)
e)

f)

VPMInput2014.gms

VPMCore2014.gms

VPMOutput2014.gms

VPMSim2014.gms

Open the first of these files from within the IDE interface by selecting the ‘File’ menu at
the top left of the interface, selecting ‘Open’, locating the file “VPMSim2014.gms” and
clicking on the ‘Open’ button (Figure 3). This file contains command lines to instructs
GAMS to include “VPMInput2014.gms”, “VPMCore2014.gms” and
“VPMOutput2014.gms”. The IDE interface allows a number of files to be open
simultaneously. While all GAMS files of VPM2014 are required to be in the same file
location, only the fourth (i.e. VPMSim2014.gms) needs to be open for the model to run.

=& gamside: C:\VPM2014\VPM2014.gpr

File Edit Search Windows Utilities Model Libraries Help
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Scentiiaces 1w vpMCore2014 5/22/2015 11:24 AM
- = VPMInput2014 7/20/2015 2:17 PM
Deskiop 4] VPMInput2014 7/10/2015 3:21 PM
= £ VPMOutput2014 7/20/2015 2:25 PM
el “jvemoutput2014 7/20/2015 226 PM
Libraries | [Z] VPMSim2014 7/20/2015 2:20 PM_
Computer
w
Network < 1 | ,
File name: [vPMSim2014 ~| Open
Files of type: |AII files (*.%) LI Cancel
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Figure 3: Opening the VPM2014 files in GAMS screenshot



Ensuring the Excel input and output files is available to GAMS

The VPM2014 Model uses input data from the excel file “VPMInput2014.xIsx” and extracts
its outputs into the excel file “VPMOutput2014.xlsx”. These excel spreadsheets must be
available from the same file location as the three GAMS instruction files, and it must be
saved. Before running the GAMS model, ensure you have this file in the correct location
(Figure 3).

Running the VPM2014 Model

To run the VPM2014 Model, make sure “VPMSim2014.gms” is open and selected (If other
gms files are open, ensure that “VPMSim2014.gms” is selected). Run the model by either
clicking the run icon with a red arrow on the tool bar (Figure 4), selecting the ‘File’ menu
and clicking “Run”, or pressing F9.

28 gamside: C\VPM2014\VPM2014.gpr - [CAVPM2014\VPMSin2014.gms] S
=& File Edit Search Windows Utilities Model Librarief Help
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New Ctrl+N
Open Ctrl+O
Open in Editor

Open in project directory
Reopen Alt+R
Open in New Window Shift+Ctrl+O

View in Explorer

Model Library »
Project >
Run F9
Compile Shift+F9

Figure 4: Running VPM2014 model screenshot

This causes GAMS to run and the process window to appear, which gives a log (actually
containing the LOG file) or the steps GAMS goes through in running the model. The user can
narrow the process window and drag it to the right so that the list file (LST) window can be
viewed (Figure 5).
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Figure 5: The process window and list file screenshot

Opening and navigating around the output
This can be done in one of two ways:

a) Using the process window

Double clicking on lines within the process window allows you to access program output in

general as well as at particular locations (Figure 5). The positioning of your access is
determined by the colour of the line you double click on:

Blue line: Jumps to the line in a LST file corresponding to the blue line in the process

[ ]
window. Blue lines also open put and other files created by the run,

e Non-bolded black line: Jumps to the location of the last previous blue Line in the LST file,
and

[ ]

Red line: Identifies errors in teh source file. When you click on a red line, the cursor

jumps into the source (GMS) file at the location of the code that caused the error. Error
description text appears in the process window and in the LST file that is not
automatically addressed. When the shift key is held down you will go to the

corresponding spot in the LST file.

b) Using the list file navigation window.

Clicking on the lines in the LST file allows access to program output both in general and at
particular locations (see Figure 5). The positioning of the cursor is determined by the type of
line you click on. A list of types of lines typically in the LST file is given in Table 1.
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Table 1: Types of lines found in LST files

Name of Line in LST File
Navigation Window

Compilation
Error Messages
Equation listing

Equation

Variable listing

Variable

Model statistics

Solution Report

SolEQU

SolVAR

Execution

Display

Function and Destination When Clicked

Jumps to top of echo print in LST file
Jumps to list of error messages when compilation messages incurred
Jumps to list of equation contents as illustrated in the output section

Expandable allowing jump to beginning of list of contents for each
individual equation block with contents as shown in the output
section

Jumps to list of variable contents as illustrated in the output section

Expandable allowing jump to beginning of list of contents for each
individual equation block with contents as shown in the output
section

Jumps to model statistics part of LST file as illustrated in the output
section

Jumps to model summary solution report

Expandable allowing jump to beginning of list of solution for each
individual equation block with contents as shown in the output
section

Expandable allowing jump to beginning of list of solution for each
individual variable block with contents as shown in the output section

Jumps to beginning of post solve execution

Expandable allowing jump to displays of specific parameters and other
items

11



3. How to make changes to the VPM2014 Model structure

The easiest way to make changes to the VPM2014 Model structure is by changing the GAMS
instructions within the gms files using the IDE interface. This requires some knowledge of
the current structure of the model, and of the variable, parameter, scalar and vector names
used in GAMS.

Appendix 1 presents the definitions of the model set/subset names. Column 1
provides a description, column 2 shows the GAMS set names, column 3 provides the
elements included in each set.

Appendix 2 presents the definition of model input parameters. Column 1 show the
GAMS input parameter names, column 2 provides a description, column 3 show the
units;

Appendix 3 presents the definition of model variables, equations & other
parameters. Column 1 show the GAMS variable/equation/parameter names, column
2 provides a description, column 3 show the units;

Appendix 4 presents the definition of summary model output parameters. Column 1
show the GAMS output parameter names, column 2 provides a description, column
3 show the units;

Appendix 5 presents the VPM2014 core system of equation and equalities in normal
algebraical forms .

Ways to find and/or replace text strings

The dialogs for finding text within the IDE involve use of three icons on the tool bar picturing
a flashlight, and the search box just to the right of the flashlight icons (Figure 6).

File Edit Search Windows Utilities Model Libraries
B RAR SR |SURPLUS |
I

Figure 6: GAMS buttons used for finding text screenshot

To find text, type the text string you are after in the search widow (the example in Figure 6
is “SURPLUS”). In turn, clicking on the first icon finds the first occurrence of what you want
in the current file, while clicking on the second icon finds the next occurrence in the current
file. Finally, clicking on the third icon finds all occurrences in a specified group of files.

12



4. How to make changes to model inputs

Most model inputs are housed within the excel file VPMInput2014.xls. The user can change
data within this file, re-save the file and close it. If the excel file is not saved, any changes to
model inputs will not be recognised within GAMS. If the user would like to change the name
of the Excel file, the updated name must be changed within “VPMInput2014.gms” in the line
reading SCALL 'GDXXRW VPMInput2014.XLSX skipempty=0 trace=2 index=INPUT!A3' (see
Figure 7).

2 gamside: C:AVPM2014\VPM2014.gpr - [CAVPM2014vPMInpu014oms R

& File Edit Search Windows Utilities Model Libraries Help

EHRERARA =] @) 8| m|

*Call for parameter values stor

SCALL 'GDXXRW VPMInput2014.XLSX skipempty=0 trace=2 index=INPUT'A3"
SGDXIN VEMInput2014.,GDX

S$LOAD MPAR AREAQO YIELDO PRODO CRPRODO LVPRODO DECO PDO PDB PWO TRADE
SLOAD IDEN1 IDENZ KM YPCO POP0O FEEDSHARE ADJ YGR PGR

SLOAD PWGR TAXO

$LOAD AREAE YIELDE LVELAS LVFDEL DYE DPE FDELAS
Figure 7: Screenshot of GAMS text which calls input data from VPMInput2014.gms

2 7 £37
el = dal =N 7
in ex

| ] T
=0l Led L10E

The excel file contains data for 29 variables. A list of these variables and their location within
the spreadsheet are contained within the block A4:E32. For example, parameters called
“MPAR” are to be found at INPUT!A35:F39. Users can go to this location and change the
values of these parameters or exogenous variables.

The variables that users are most likely to want to change are income, population,
productivity and world price growth.

A small amount of input data is housed in the GAMS file “VPMInput2014.gms” (see Figure
8a&b). Changes to this data must be made directly into this GAMS file.

’DE s gamside: C:\VPM2014\VPM2014.gpr - [C:\VP} ut20]
'DE File Edit Search Windows Utilities Model lerarles Help

o/@%> %) =1 o] eln|
| VPMInput2014.gms

| INERO = '21.300 ;
Figure 8a: Input data within “VPMInput2014.gms” screenshot
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ma gamside; CAVPM2014\VPM2014.gpr - [CAVPM2014\VPMInput2014.gms
e File Edit Search Windows Utilities Model Libraries Help

EECRE SR

| WPMInput2014.gms

TP (RW, RRW) = 80.285 (KM(RW,RRW, '"ROAD"')) + 1.17*KM(RW,RRW, 'ROAD")
4+ 57.755 (KM(RW,RRW, 'SEA')) + 0.42*KM(RW,RRW, 'SEA")
- 0.000099*KM (RW, RRW, 'SEA' ) **2 ;

TP (RW, RRW) $ (KM (RW, RRW, 'LINK')=0) = 9999 ;

TP (RW, RW) =0 ;

Figure 8b: Input data within “VPMInput2014.gms” screenshot

A number of important parameters for policy shocks is located in GAMS file
“VPMSim2014.gms” such as: Import and export quotas (QUOTA), technology growth (TGR),
nominal exchange rate growth (NERGR), population growth multiplier (PGM), income
growth multiplier (YGM), world price growth multiplier (PWGM), tax rate growth (TAXGR);

8% gamside: CAVPM2014\VP
e File Edit Search Windows

B B % ¥ | Sl -] | &8sl

VPIJSiméUM.gms
PGM =1.0 ;
YGM = 1.0 ;
PWGM (C) = 1.0 ;

Figure 9: Input data within “VPMSim2014.gms” screenshot

VPM2014 contains a number of sets defined within “VPMInput2014.gms”. Changes to these
sets must be made directly into this file. One of these set is titled “T” and determines the
number of years for which the model is run (Figure 10). When this set is defined as
“/2014/”, then the model will run for the baseline year only. When it is defined as
“/2014*2025/”, then it will run for the baseline year 2014 to year 2025 including all years in

between.

, { 'PM2014.gpr - [C:\VPM2014\VPMInput2014.gms]
e File Edit Search Windows Utilities Model Libraries Help

EEER <] @] @|n]

| VPMinput2014.gms

SETS
T Time period / 2014*2025 /
Figure 10: The definition of VPM2014 sets within “VPMInput2014.gms” (including number
of years for which the model is run) screenshot
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5. How to set up and change VPM2014 output tables

Summary output tables by regions and years for key indicators: supply, demand, trade and price are
deflned within GAMS file “VPMOutput2014.gms” (see Flgure 11).
= gamside; C\Users' ini msdiriprojdi
LE File Edit Search Windows Utilities Model Libraries Help

o % v % el

1_VPMInput2014_NNOue.gms| E_VPMCDrEQDH_NNOue.ng”S_VPMOutputEM4_NNOue_gms 4_VPMBaseSimED14_NNQue.gms|

NMNQue_Docs\20154CAP\CAP-ILRI VPM2(

*Construct regional demand summary table

D RTABLE(T,R,"D TP") = DFOODTR(T,"TRADPIG",R) ;

D RTABLE(T,R,"D CP") = DFOODTR(T,"COMMPIG",R) ;

D RTABLE(T,R,"D MP") = DFOODTR(T, "MODPIG",R) =

D RTABLE(T,R,"D MZH") = DFOODTR(T,"MAIZE",R) ;

D RTABLE(T,R,"D MZL") = DFEEDTR(T,"MAIZE",R) ;
*Construct regional supply summary table

S RTABLE(T,R,"S TP") = SLVTR(T,"TRADPIG",R) ;

S RTABLE(T,R,"S CP") = SLVTR(T,"COMMPIG",R) ;

S RTABLE(T,R,"S MP") = SLVTR(T,"MODPIG",R) ;

S RTABLE(T,R,"S Mz") = SCRTR(T,"MAIZE",R) ;

*Construct regional demand price summary table
DP RTABLE (T,R,"DP TP")= PDTR(T,"TRADPIG",R)
DP RTABLE(T,R,"DP_CP")= PDTR(T, "COMMPIG",R)
DP_RTABLE (T,R,"DP _MP")= PDTR(T,"MODPIG",R) ;
DP RTABLE (T,R,"DP MZi")= PDTR(T,"MAIZE",R) ;

Figure 11: Screenshot of the command line for summarizing simulation output

s M

All the calculated outputs in GAMS file “VPMOutput2014.gms” then are sent to excel file
“VPMOutput2014.xlsx” using special commands ((see Figure 12):
SLIBInclude XLDUMP S_RTABLE VPMOutput2014.xIsx %sim_name%!C5:H89

1201 S\CANCAP-ILRI VPM20)

FA2UENEANNGAPILIE VEME0AS

w‘{‘““ rm;n»wa*q‘ Y W\&-

%s File Ednt Swm Wunoovas ties  Model Ubranes Help

&) (] % ¥ %l =l | &/ »|
1_VPMIru2li1 4 NNOwa gims | 2 VFMCora2014_NNGus ors || 3_VPMOMpo20i4_WNQue gms 4 VFMBassSim2014_NNOug gms

$LIBInclude XLDUMP S RTABLE VPMOutputZ014 NNQue.xlsx %sim_name%!C5:HE9
$LIBInclude XLDUMP D RTABLE VPMOutput2014 NNQue.xlsx Rsim name%!I5:089
$LIBInclude XLDUMP NETQUTFL _RTABLE VPVOu'purz 014 NNQue. x18X $sim _name%!P5:Y89
$LIBInclude XLDUMP DP_RTABLE VPMOutput201l4 NNQue.xlsx %sim name%!Z5:AEBS9

Figure 12: Screenshot of the command line for sending output to excel file

The VPM2014 creates the following output summary variables and parameters:
e DFOODTR: Regional food demand at time T (1000 tons);

e DFEEDTR: Regional feed demand at time T (1000 tons);

e SCRTR: Regional crop supply at time T (1000 tons);

e SLVTR: Regional livestock supply at time T (1000 tons);

e PSTR(T,C,R): Regional producer price at time T (D per kg);

e PDTR: Regional consumer price at time T (D per kg);
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e XTR: Regional exports at time T (1000 tons);

e MTR: Regional imports at time T (1000 tons);

e TQTR: Regional TQ in-out (exclude R to R) at time T (1000 tons);
e TQXTR: Regional TQ outflow at time T (1000 tons);

e TQMTR: Regional TQ inflow at time T (1000 tons);

All summary output indicators are stored in the sheet “SIM-BASE” of the excel file
“VPMOutput2014.xIsx”. User can use excel command to aggregate the model outputs or
draw graphs or further analyze the output data.
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Appendix

Appendix 1: Definition of model set names

Description Set name Elements in the set
Time period T 2014*2025
All commodities C MAIZE, TRADPIG, COMMPIG, MODPIG
Regions incl world RW NMM, RRD, NCC, SCC, CH, SE, MRD, WORLD
Sub-set regions excl world R(RW) NMM, RRD, NCC, SCC, CH, SE, MRD
Urban & rural u URBAN, RURAL
Subset of livestock commodities | L(C) TRADPIG, COMMPIG, MODPIG
Subset of crop commodities F(C) MAIZE

Note:

MAIZE - Crops used for human & animal; TRADPIG - Traditional pig farms; COMMPIG -
Commercial pig farms; MODPIG - Modern pig farms; NMM - North Moutainous and Middle

Lands; RRD - Red River Delta; NCC - North Central Coast; SCC - South Central Coast; CH -

Central Highlands; SE - South East; MRD - Mekong River Delta; WORLD - Rest of world.

Appendix 2: Definition of model input parameters

Parameter name Description Unit
MPAR(C,*) Market parameters: CONV, PMARGPR, CTA, XPROC, FEEDCONV
CONV(C) Conversion ratio from farm weight to consumer weight
PMARGPR(C) Processing costs Fraction
CTA(C) Commodity transportation cost adjustment factor
XPROC(C) Extra cost of processing for export VND per Kg
FEEDCONV(C) Amount of aggregate feed per unit of meat
AREAO(F,R,U) Original crop area for urban-rural consumption 2014 1000 Ha
YIELDO(F,R,U) Original crop yield for urban-rural consumption 2014 Tons per ha

Original crop & LVSK production for urban-rural consumption
PRODO(C,R,U) 2014 1000 tons
CRPRODO(C,R,U) Original crop prod. for urban-rural consumption 2014 1000 tons
LVPRODO(C,R,U) Original lvstck prod. for urban-rural consumption 2014 1000 tons
DPCO(C,R,V) Original per capita food cons. 2014 kg per year
PDO(C,R,U) Original consumer price 2014 VND per Kg
PDB(C,R,U) Base scenario consumer price VND per Kg
PWO(C,*) Original world prices 2014 USS per ton
TRADE(C,*) Import and export volumes 2014 1000 tons
IDEN1(C,F) Identity matrix for proper dimension of feed demand in inflows
Identity matrix for proper dimension of livestock Supply in
IDEN2(C,L) outflows
KM(RW,RRW, *) Distance Km
Mill. VND per

YPCO(R,U) Urban & rural per capita income in 2014 year

17




1000
POPO(R,U) Urban & rural population in 2014 inhabitants
Share of each feed in total composite feed demanded by
FEEDSHARE(L,F) animal Fraction
Adjustment factor to match VHLSS consumption with national
ADJ(C,*) data
YGR(R,U) Annual income growth 2015-25 Fraction
PGR(R,U) Annual pop growth 2015-25 Fraction
AREAE(F,R) Elasticity of crop area with respect to output price
YIELDE(F,R) Elasticity of crop yield with respect to output price
LVELAS(L,LL,R) Elasticity of livestock supply with respect to output prices
LVFDEL(L,F) Elasticity of livestock supply with respect to feed prices
DYE(C,R,U) Food demand elasticity with respect to consumer income
DPE(C,CC,R,U) Food demand elasticities with respect to food prices
FDELAS(F,F) Elasticity feed Demand with respect to feed own prices
PWGR(T,C) Annual growth of world prices
1000 VND
NERO Nominal exchange rate in 2014 per USS
DFOODO(C,R,U) Original food demand 1000 tons
DFEEDO(C,R,U) Original feed demand 1000 tons
DO(C,R,U) Original food-feed demand 1000 tons
SO(C,R,U) Original product supply 1000 tons
NATDO(C) National food-feed demand 1000 tons
NATSO(C) National product supply 1000 tons
TP(RW,RRW) Cost of transportation VND per Kg
MARGPR(C,R,U) Processing costs VND per Kg
MARGD(C,R,RR,U) [ Marketing margin for internal trade VND per Kg
MARGM(C,R,U) Marketing margin for imports VND per Kg
MARGX(C,R,U) Marketing margin for exports VND per Kg
MARGW(C) Margin between world FOB and CIF prices USS per ton
PSO(C,R,U) Original producer price VND per Kg
PSB(C,R,U) Producer price in base scenario VND per Kg
FEEDNAT(C) Original national feed demand 1000 tons
Appendix 3: Definition of model variables, equations & other parameters
Variable name Description Unit
Positive variables
PS(C,R,U) Producer price VND per kg
PD(C,R,U) Consumer price VND per kg
TQ(C,R,RR,U) Transport of goods 1000 tons
X(C,R,U) Exports 1000 tons

18




M(C,R,U)

IXT(C)

IMT(C)
Variables
DFOOD(C,R,U)
DFEED(F,R,U)
AR(F,R,U)
YLD(F,R,U)
SCR(F,R,U)
SLV(L,R,U)
PW(C)
Equations

AREA

YIELD

CSUPPLY
LSUPPLY
FOODDEM
FEEDDEM
INFLOW
OUTFLOW
DOM_TRADE
IMPORTS
EXPORTS
MQUOTA
XQUOTA
Dynamic parameters
SCRT(F,R,U,T)
SLVT(L,R,U,T)
DFOODT(C,R,U,T)
DFEEDT(F,R,U,T)
TQT(C,R,RR,U,T)
XT(C,R,U,T)
MT(C,R,U,T)
PST(C,R,U,T)
PDT(C,R,U,T)
PWT(C,T)

YPCT(R,U,T)
POPT(R,U,T)

NERT(T)

Policy parameters
TAX(C,*)
QUOTA(C,*)

Imports
Implicit export tax
Implicit import tax

Demand for food
Demand for feed
Planted area of feed
Yields of feed crops
Supply of feed crops
Supply of livestock
World FOB price

Crop area equation
Crop yield equation
Crop supply equation
Livestock supply equation
Food demand equation
Feed demand equation
Shipments into region
Shipments out of region
Domestic trade

Imports

Exports

Import quota limits
Export quota limits

Supply of crops at time T

Supply of livestock at time T

Demand for food at time T

Demand for feed at time T

Transport from one region to another at time T
Exports attime T

Imports at time T

Producer price attime T

Consumer price at time T

World (FOB) price at time T

Income per capita at time T
Population at time T

NER at time T

Import and export taxes
Import and export quotas

1000 tons
VND per kg
VND per kg

1000 tons
1000 tons
1000 ha

Tons per ha
1000 tons CW
1000 tons CW
USS per ton

1000 tons CW
1000 tons CW
1000 tons CW
1000 tons CW
1000 tons CW
1000 tons CW
1000 tons CW
VND per kg
VND per kg
USS per ton
Mill. VND per
year

1000 inhabitants

1000 VND per
uss

Fraction
1000 tons
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TGR(C) Technological growth rate for each commodity Fraction
SGR(C) Supply growth scaling factor
NERGR Growth rate of NER Fraction
DYEG(C,U) Annual income elasticity grow
DYEC(C,U) Income elasticity multiplier
PGM Population growth multiplier
YGM Per capita income growth multiplier
PWGM(C) World price growth multiplier
Appendix 4: Definition of summary model output parameters

Parameter name Description Unit
Set of regional summary statistics for each period
DFOODTR(T,C,R) Regional food demand at time T 1000 tons
DFEEDTR(T,C,R) Regional feed demand at time T 1000 tons
SCRTR(T,F,R) Regional crop supply at time T 1000 tons
SLVTR(T,L,R) Regional livestock supply at time T 1000 tons
PSTR(T,C,R) Regional producer price at time T VND per kg
PDTR(T,C,R) Regional consumer price at time T VND per kg
XTR(T,C,R) Regional exports at time T 1000 tons
MTR(T,C,R) Regional imports at time T 1000 tons
TQTR(T,C,R,RR) Regional TQ in-out (exclude Rto R) attime T 1000 tons
TQXTR(T,C,R,RR) Regional TQ outflow at time T 1000 tons
TQMTR(T,C,RR,R) Regional TQ inflow at time T 1000 tons

D_RTABLE(T,R,*)
S_RTABLE(T,R,*)
DP_RTABLE(T,R,*)
SP_RTABLE(T,R,*)
XM_RTABLE(T,R,*)
TQX_RTABLE(R,RR, T, *)
TQM_RTABLE(RR,R,T,*)
NETOUTFL_RTABLE(T,R,*)

Set of summary regional output tables

Regional summary demand table
Regional summary supply table
Regional summary demand price table
Regional summary supply price table
Regional summary trade table
Regional summary TQ-out table
Regional summary TQ-in table
Regional summary net outflow table

Appendix 5: Definition of model core structure

VPM2014 has 13 block of equations (and inequalities) with 778 single equations (and
inequalities), and 14 blocks of variable with 782 single variables. The system of equations
(and inequalities) is solved using Mixed Complememtary Problems (MCP) programing in
GAMS environment repeatedly for each of 10 selected time periods from 2015 to 2025.

The details of VPM2014 structure in normal mathematical form is as follows:
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1. Group of variables:

Pcs,r,u: Producer price (VND per kg);

Pc]?r,u: Consumer price (VND per kg);

TQcy ru: Transport of goods (1000 tons);

Xcru: Exports (1000 tons);

X¢rut Imports (1000 tons);

IXT.: Implicit export tax (VND per kg);

IMT,: Implicit import tax (VND per kg);

D¢ ru: Demand for food (1000 tons);

DEr,u: Demand for feed (1000 tons);

AR¢ .y : Planted area of crops (1000 ha);

YLDs,y: Yields of crops (tons per ha);

Sgr‘u: Supply of crops (1000 tons of consumer weight);
Slljr,u: Supply of livestock (1000 tons of consumer weight);
PY: World F.0.B. price (USS$ per ton).

2. System of equations & inequalities:
2.1. Crop area equation in normal mathematical form:
log(ARﬁr,u) = oq?r,u + Zf'[Béf',r,u * log(P?,i,u)]
Where:
AR: Feed crop area;
o®: Intercept of crop area function;
BA: Elasticity of feed crop area with respect to its own & cross-prices;
PSF: Feed crop producer price;
fand f': Feed crop index and its alias;
r: Region index;
u: Urban-rural index.
2.2. Crop yield equation in normal mathematical form:
log(YLDf,r,u) = oaf{r,u + Bgr,u * log(Pf,sr},Tu
Where:
YLD: Crop yield;
oY Intercept of feed crop yield function;
BY: Elasticity of feed crop yield with respect to its own price.
2.3. Crop supply equation in normal mathematical form:
Sfru = (ARgpy * YLDg, ) % CNVE
Where:
SF: Feed crop supply;
CNV¢: Conversion ratio from producer weight to consumer weight for feed crops.
2.4. Livestock supply equation in normal mathematical form:
log(sll,‘r,u) = o(ll,‘r,u + Zl’[B{jl’,r,u * log(Pl§,];,u)] + Z:f[Y{jf,r,u * log(Pf,srlTu)]
Where:
Sl Livestock supply;
or: Intercept of livestock supply;
BL: Elasticity of livestock supply with respect to own and cross-price of livestock
products;
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y": Elasticity of livestock supply with respect to feed crop producer price;
PSL: Livestock producer price;
land 1": Livestock index and its alias.

2.5. Food demand equation in normal mathematical form:

log(Deru) = @y + Z[BCD'C"““ *10g(P? . )] + Yeru * 10g(Yy,y) + 10gPOP,, 1000
CI

Where:
D: Food demand;
oP: Intercept of food demand;
BP: Elasticity of food demand with respect to own and cross-price of food;
yP: Elasticity of food demand with respect to consumer income;
PP: Food demand price;
Y: Consumer income;
c and c’: All commodity (all food) index and its alias;
POP: Population.
2.6. Feed demand equation in normal mathematical form:

log(DEr,u) = O‘Er,u + Z [Bgf',r,u * log(PfI’J,E,u)] + Z[Ygl,r,u * log(Pl,SrL,‘u)] + log <Z Sl%r,u)
f! 1 1

Where:
DF: Feed demand;
of: Intercept of feed demand;
BF: Elasticity of feed demand with respect to own and cross-price of feed;
vF: Elasticity of feed demand with respect to livestock producer price;
PPF: Feed demand price.
2.7. Commodity inflow inequality in normal mathematical form:
Zr’ TQc,r’,r,u + Mc,r,u = Dc,r,u + Zf[IDi,f * Dgr,u]
Where:
TQ: Transport-in commodity quantity;
M: Commodity import;
ID?: Identity matrix for proper dimension of feed demand/supply in inflows.
2.8. Commodity outflow inequality in normal mathematical form:
Zl[ng,l * SlL,‘r,u] + Zf[IDé,f * Sll:,‘r,u] =N TQc,r,r’,u + Xc,r,u
Where:
TQ: Transport-out commodity quantity;
X: Commodity export;
ID?: Identity matrix for proper dimension of livestock supply in inflows.
2.9. Domestic trade inequality in normal mathematical form:
PS:u/CNV, + MARGp, .+ = PD, |
Where:
PS: Commodity producer price;
PP: Commodity consumer price;
CNV, Commodity conversion ratio from producer to consumer weight;
MARGP: Marketing price margin for internal trade.
2.10. Import inequality in normal mathematical form:
(P + MARGY) * NER (1 + TAXM) + IMT, + MARGM, , > P5, ,
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Where:
PW: World commodity (FOB) price;
MARGY: World commodity price margin (CIF-FOB);
TAXM: Import tax in fraction;
IMT: Implicit import tax;
MARGM: Commaodity import price margin.
2.11. Export inequality in normal mathematical form:
PS.u/CNV. + MARGZ, , + IXT, = P}V = NER * (1 — TAXX)
Where:
TAXX: Export tax in fraction;
IXT: Implicit export tax;
MARGX: Commodity export price margin.

2.12. Import quota limit inequality in normal mathematical form:

QT = ¥ XuMeru
Where:
QTM: Import quota limits.

2.13. Export quota limit inequality in normal mathematical form:

QTg( 2 Zr ZUXC,I',U
Where:
QTX: Export quota limits.
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